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Introduction

Congratulations! 
The MainConcept ShowCase player is a simple sample tool for experts and developers
who want to evaluate the power of some of the most important MainConcept decoders
themselves. The player makes only use of the MainConcept DirectShow filters, which
come with it, in order to allow video and audio playback in highest quality. Other filters
installed on the system do not interfere with our new standalone product. It is the perfect
way to evaluate the MainConcept DirectShow filters, because it includes the same filter
versions as our renowned Codec SDK, and it gives you an idea of their versatile function-
alities if you plan to license and include them into your own software. Testing the power as
well as the high decoding quality of the MainConcept DirectShow filters is only a matter of
drag-and-drop now!

MainConcept ShowCase supports H.264/AVC, SVC Baseline Profile, MPEG-1, MPEG-2,
VC-1, VC-3, DV/DVCPRO 25/50/HD, Motion JPEG, JPEG2000 and MPEG-4 Part 2 as
video formats. For audio, you are able to play back streams that include MPEG, LPCM
and AAC audio. Please note that the player is only a demo version, i.e. it always adds a
watermark to the preview and has a audio limitation for AAC. 

As file formats MPEG-2 Program/Transport Stream, AVI, DIF, WMV (including VC-1 video
streams), MXF, 3GP, and MP4 are supported. Of course, you are also able to play back
MPEG-2, H.264/AVC and MPEG-4 Part 2 Elementary Streams.
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Moreover, MainConcept ShowCase includes a Network Source filter that allows stream
receiving of MPEG-2 PS/TS, MP4, and Elementary streams with the above formats. So
the application works like a receiver tool when the video is streamed over a network.

MainConcept ShowCase includes the following DirectShow filters:

• H.264/AVC Video Decoder filter 
• SVC Video Decoder filter
• MPEG-2 Video Decoder filter 
• MPEG-4 Part 2 Video Decoder filter 
• VC-1 Video Decoder filter 
• VC-3 Video Decoder filter 
• DV/DVCPRO 25/50/HD Video Decoder filter 
• JPEG2000Video Decoder filter
• Motion JPEG Video Decoder filter 
• AAC Decoder filter
• MPEG Audio Decoder filter
• MP4 Demuxer filter
• DV Splitter filter
• DV Dif Parser
• MPEG Push Demultiplexer filter
• MPEG Pull Demultiplexer filter
• MXF Demultiplexer filter
• Network Source filter

ShowCase now also includes a SVC Decoder Beta version, so that you can have a first
look at this exciting new format. SVC (Scalable Video Coding) is a new extension to the
H.264/AVC standard that allows a video stream to be encoded with multiple quality layers.
In a single step and into a single bitstream, quality layers are encoded with different res-
olutions (Spatial), different quality levels (SNR/Quality/Fidelity) or different frame rates
(Temporal) and combinations of these features. The SVC Decoder and a SVC enabled
Streaming Server can skip layers based on the decoding device abilities or the bandwidth
restrictions of the delivery network.

If the DivX Decoder filter is registered on your system, you can use it for playing back
DivX encoded clips in MainConcept ShowCase as well.

In case of VC-1 decoding, MainConcept ShowCase uses the WMA Audio Deocder and
ASF Reader that comes with the Windows operating system.

After successful evaluation, we are pretty sure that you want to know where to get the
powerful decoding technology of MainConcept ShowCase that works behind the scenes,
in order to implement it in your own application. That’s almost as easy as testing the Main-
Concept DirectShow filters. For detailed information on licensing and pricing, please con-
tact your local sales representative or write an e-mail to sales@mainconcept.de.
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If you have already registered full versions of the MainConcept Decoder filters on your
system, these are automatically used when working with the ShowCase player.

And now we wish you a lot of fun working with our ShowCase sample player, and of
course, reading this manual.

Supported Streams and Formats
Here is an overview on the streams and formats that are currently supported by MainCon-
cept ShowCase demo application:

• MPEG-1 System Stream (ISO/IEC 11172-1)
• MPEG-2 Program Stream (ISO/IEC 13818-1)
• MPEG-2 Transport Stream (ISO/IEC 13818-1)
• MPEG-1 Video (ISO/IEC 11172-2)
• MPEG-1 Audio (ISO/IEC 11172-3)
• MPEG-2 Video (ISO/IEC 13818-2)
• MPEG-2 Audio (ISO/IEC 13818-3)
• H.264 Video Streams (ISO/IEC 14496-10) or H.264 packetized into Transport Stream 

(ISO/IEC 13818-1)
• AAC (ISO/IEC 13818-7 and ISO/IEC 14496-3)
• MPEG-4 (ISO/IEC 14496-2)
• MPEG-4 System Streams (ISO/IEC 14496-14)
• 3GPP2 System Streams (3GPP TS 26.234)
• H.263 Video (ITU-T Recommendation)
• DV Video Streams (IEC-61834)
• DVCPRO 25/50 Video Streams (SMPTE 314M)
• DVCPRO HD Video Streams (SMPTE 370M)
• VC-1 Video Streams (SMPTE 421M-2006)
• VC-3 Video Streams (SMPTE 2019-2006)
• JPEG2000 Video Streams (ISO/IEC 15444-1)
• Motion JPEG Video Streams
• Panasonic P2 AVC-Intra Class 50 and Class 100 Streams
• Sony XDCAM HD, XDCAM DV (DVCAM) and XDCAM IMX MXF Streams
• Sony XDCAM EX Streams
• Panasonic P2 DVCPRO MXF Streams
• JPEG2000 MXF Streams
• SVC Baseline/Main Profile Streams
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MainConcept ShowCase can receive the following streams and formats over a network:

• MPEG-1 System Stream
• MPEG-2 Transport Stream
• MPEG-2 Program Stream
• MPEG-1 Video
• MPEG-1 Audio
• MPEG-2 Video
• MPEG-2 Audio
• AVC/H.264 Video
• SVC Video
• MPEG-4 Video
• VC-1 Elementary Stream
• AAC
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Getting Started

System Requirements
Decoding can be very resource-intensive. To achieve acceptable playback speeds, we
recommend at least these minimum specifications: 

Operating system: Microsoft® Windows® XP, Vista or Windows 7 (32-bit and 64-bit).

Processor: For HDV playback, the recommended minimum requirements are an Intel®
Pentium® 4 processor 3.06 GHz or faster with Hyper Threading Technology. For HD and
AVCHD decoding, the recommended minimum requirements are an Intel® DualCore pro-
cessor 2.4 GHz or faster. We also recommend to install always the current Service Pack
for the used operating system.

RAM: 1 GB or more

MainConcept ShowCase will work on many systems not meeting these specifications,
although decoding speed will be slower. 

The demo version of MainConcept ShowCase has a decoding limitation
of 30 seconds for files which include AAC audio, i.e. after this period of
time audio is muted and only video is played back correctly. 

Streams containing Dolby Digital (AC-3), the audio cannot be decoded
due to license restrictions. You will only have video playback in this case
after muting audio.
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Installing the MainConcept ShowCase Player

If you received the MainConcept ShowCase demo application on a CD, follow the
included installation instructions. If you downloaded it, please follow these steps:

1. Double-click on the ShowCase Setup file if necessary. A splash screen and progress
indicator will appear.

It may take a few moments until the installation process begins.

2 The Welcome dialog will appear on the screen. Please click Next to continue.
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3 When the license agreement appears on the screen, review it carefully, then click Yes
if you agree to the terms and you want to continue the installation.

If you do not click Yes, the installation process will be aborted.

4 In the following dialog box, you can choose the location where the software player
files will be stored on your computer.

You can accept the default settings or click the Browse... button and select a different
destination directory. Click Next to proceed. You can accept the default settings, enter
a new folder name or select any existing folder. Then click Next. 
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5 In the Select Features window, you can select the features and components you
want to install. You do not necessarily need to install the ShowCase player. For exam-
ple you can only install the demo decoders or a set of demo decoders you require for
testing. Simply select the desired item you want to install from the list. After you are
done, click Next to install them.

If you want to add components or features that have not installed during the first instal-
lation, please start the ShowCase setup file again, and choose Modify. During the
installation process, select the items you want to add or even remove now. 

6 Now the player installation starts. An indicator will show the installation process.
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7 The installation process will finish then. When the following dialog box appears, click
Finish to complete the ShowCase player setup.

The MainConcept ShowCase evaluation player is now installed on your computer.
You can launch it from your Windows start menu or from the shortcut on your desktop.

If you ever need to uninstall the program, you can launch the uninstaller from the Add
or Remove Programs option in the Windows Control Panel.

Or, you can launch the uninstaller by running the Setup program again.
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Enable the Remove option and click Next to uninstall the MainConcept ShowCase
application from your system. Then follow the on-screen prompts. 

You will need to confirm that you want to remove MainConcept ShowCase. Click OK
to start the uninstall process.

You will be notified when uninstallation is complete. Click Finish.
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Quickstart Tutorial
The ShowCase application is designed for easy, efficient testing of the
MainConcept Decoder DirectShow filters. the user-friendly software
makes it easy to play back video and audio streams. Here is a short tuto-
rial that will show you how to use the player.

1 Launch the MainConcept ShowCase application if it is not already running. The main
window will appear on the screen.

2 In this tutorial we want to play back a file, that is stored somewhere on your hard
drive. For that reason we select File Mode in the File menu. 
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3 Then click the Select the network stream or playback file... button on the main win-
dow and select in the following dialog choose the desired file for playback. You can
also choose Select Source... in the File menu to open Load Playback File dialog.

4 To start the decoding process in MainConcept ShowCase, click the Play button. Dur-
ing playback, it turns into a Pause button that enables you to pause the preview any 
time. Clicking the button again, continues the decoding again.
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5 Click the Stop button to finish the playback.  

Now you can open the next file for decoding or change the mode, so that you receive
and playback streams that are streamed over a network. It is your decision what you
want to do next in the MainConcept Decoder evaluation process!

Now we will take a tour through the MainConcept ShowCase interface and show you how
to use the various components in detail.
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The ShowCase Player Interface
The MainConcept ShowCase evaluation player application enables you to play back vid-
eos, streamed over the network or the files which are already on the system. It makes use
of the renowned MainConcept video and audio decoder, demultiplexer and network
source filter. In the following chapters we give you an overview of the interface and its
numerous functions. 

The Menus
In the top part of the window are the File, Options, Preview and Help menus.

The File Menu
File Mode enables you to play back a stream
from your hard drive. You can select the desired
clip by choosing the Select Source... option.

Streaming Mode plays back a video which is
streamed over the network. When you select the
option, the MainConcept Network Source

Properties page appears on the screen where you can choose the adequate source for
preview. If the dialog does not appear automatically you can also choose the Select
Source... option.

Due to the selected mode, the Select Source... option shows a different dialog. When
File Mode is selected, the Load Playback File window appears where you can search
for the desired stream on your system. Choosing the Streaming Mode option, opens the
MainConcept Network Source Properties page which enables you to adjust several
options for streaming the videos over a network, such as server address, UDP port etc.
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You find some detailed information on the MainConcept Network Source Properties page
in the chapter The MainConcept Network Source among The DirectShow Filters’
Property Pages. 

Quit closes MainConcept ShowCase. 

The Options Menu
Under Video Decoder Properties... you get access to the included video decoders and
their property pages where you find additional decoder settings to optimize the playback
process:

H.264 Decoder Options... opens the MainCon-
cept H.264/AVC Video Decoder Properties
page which enables you to optimize the decod-
ing quality and performance if necessary. You
find some detailed information on the H.264
decoder settings in the chapter The MainCon-
cept H.264/AVC Decoder among The Direct-
Show Filters’ Property Pages. 

SVC Decoder Options... opens the MainConcept SVC Video Decoder Properties
page which enables you to optimize the decoding quality and performance of H.264/AVC
as well as SVC streams if necessary. You find some detailed information on the H.264/
AVC and SVC decoder settings in the chapter The MainConcept SVC Decoder among
The DirectShow Filters’ Property Pages. 

MPEG-2 Decoder Options... opens the MainConcept MPEG-2 Video Decoder Proper-
ties page which enables you to optimize the decoding quality and performance if neces-
sary. You find some detailed information on the MPEG-2 decoder settings in the chapter
The MainConcept MPEG-2 Video Decoder among The DirectShow Filters’ Property
Pages. 

MPEG-4 Decoder Options... opens the MainConcept MPEG-4 Video Decoder Proper-
ties page which enables you to optimize the decoding quality and performance if neces-
sary. You find some detailed information on the MPEG-4 Part 2 decoder settings in the
chapter The MainConcept MPEG-4 Video Decoder among The DirectShow Filters’
Property Pages. 

VC-1 Decoder Options... opens the MainConcept VC-1 Video Decoder Properties
page which enables you to optimize the decoding quality and performance if necessary.
You find some detailed information on the VC-1 decoder settings in the chapter The
MainConcept VC-1 Video Decoder among The DirectShow Filters’ Property Pages.

VC-3 Decoder Options... opens the MainConcept VC-3 Video Decoder Properties
page which enables you to optimize the decoding quality and performance if necessary.
You find some detailed information on the VC-3 decoder settings in the chapter The
MainConcept VC-3 Video Decoder among The DirectShow Filters’ Property Pages.
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JPEG2000 Decoder Options... opens the MainConcept JPEG2000 Video Decoder
Properties page which enables you to optimize the decoding quality and performance if
necessary. You find some detailed information on the JPEG2000 decoder settings in the
chapter The MainConcept JPEG2000 Video Decoder among The DirectShow Filters’
Property Pages.

MJPEG Decoder Options... opens the MainConcept Motion JPEG Video Decoder
Properties page which enables you to optimize the decoding quality and performance if
necessary. You find some detailed information on the Motion JPEG decoder settings in
the chapter The MainConcept Motion JPEG Video Decoder among The DirectShow
Filters’ Property Pages.

DV/DVCPRO 25/50/HD Decoder Options... opens the MainConcept DV/DVCPRO
Video Decoder Properties page for DV, DVCPRO 25/50 and DVCPRO HD which
enables you to optimize the decoding quality and performance if necessary. You find
some detailed information on the DV/DVCPRO decoder settings in the chapter The Main-
Concept DV/DVCPRO 25/50/HD Video Decoder among The DirectShow Filters’
Property Pages. 

All video decoders currently in active playback use, are marked with a
tick in the Options menu. Changing some options might have no effect
as long as the filter is still in use. You have to stop the playback to con-
figure the settings, in order to obtaint he desired effect.

The DivX Decoder Options... are only available when the corresponding decoder filter is
registered on your system. For detailed information on the DivX Decoder, please refer to
the documentation that comes with it.

Under Audio Decoder Properties... you get access to the included audio decoders and
their property pages where you find additional decoder settings to optimize the playback
process:

AAC Decoder Options... opens the MainCon-
cept AAC Decoder Properties page which
enables you to improve the audio decoding qual-
ity of the stream if necessary. You find some
detailed information on the AAC decoder settings
in the chapter The MainConcept AAC Decoder
among The DirectShow Filters’ Property
Pages. 

Layer 2 Decoder Options... opens the MainConcept MPEG Layer 2 Audio Decoder
Properties page which enables you to improve the audio decoding quality of the stream
if necessary. You find some detailed information on the MPEG Layer 2 audio decoder set-
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tings in the chapter The MainConcept Layer 2 Audio Decoder among The DirectShow
Filters’ Property Pages. 

All audio decoders currently in active playback use, are marked with a
tick in the Options menu. Changing some options might have no effect
as long as the filter is still in use. You have to stop the playback to con-
figure the settings, in order to obtaint he desired effect.

Under Demultiplexer Properties... you get access to the included demultiplexers and
their property pages where you find additional settings:

MPEG-2 Demuxer Options... opens the corre-
sponding property page which enables you to
adjust some settings of the MainConcept MPEG
Pull Demultiplexer filter if necessary. You find
some detailed information on The MainConcept
MPEG Pull Demultiplexer among The Direct-
Show Filters’ Property Pages. 

MPEG-2 Parser Options... opens the MainCon-
cept Stream Parser property page. The filter is part of the MainConcept MPEG Pull
Demultiplexer, but it does not offer any additional settings. The Stream Parser is used for
audio elementary streams.

MPEG-4 Demuxer Options... opens the corresponding property page which enables you
to adjust some settings of the MainConcept MP4 Demuxer filter if necessary. You find
some detailed information on The MainConcept MP4 Demultiplexer among The Direct-
Show Filters’ Property Pages. 

DV Splitter Options... opens the corresponding property page which enables you to
adjust some settings of the MainConcept DV Splitter filter if necessary. You find some
detailed information on The MainConcept DV Splitter among The DirectShow Filters’
Property Pages.

DV Dif Parser Options... is needed to play back DV and DVCPRO 25/50/100 frames.
However, the parser offers no property page.

MXF Demuxer Options... is needed to play back streams in an MXF container, such as
Sony XDCAM HD, Panasonic P2 DVCPRO etc. However, it offers no property page.
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All demultiplexers currently in active playback use, are marked with a
tick in the Options menu. Changing some options might have no effect
as long as the filter is still in use. You have to stop the playback to con-
figure the settings, in order to obtaint he desired effect. 

Under Network Source Properties... you get access to the included network compo-
nents and their property pages where you find additional network reception settings to
optimize the playback over the network process:

Network Source Options... opens the corresponding property page which enables you
to adjust several options for streaming the videos over a network, e.g. server address,
UDP port etc. You find some detailed information on demultiplexer The MainConcept
Network Source among The DirectShow Filters’ Property Pages. 

Push Demuxer Options... opens the corresponding property page which enables you to
adjust some settings of the MainConcept MPEG Push Demultiplexer filter if necessary. It
is used for network streaming. You find some detailed information on The MainConcept
MPEG Push Demultiplexer among The DirectShow Filters’ Property Pages. 

Use Registered Filters uses any MainConcept DirectShow filter registered on your sys-
tem for decoding when it is supported by ShowCase.   

Use Local Filters uses the MainConcept DirectShow Decoder filters that come with the
currently installed ShowCase version.

SVC Layer selection is only enabled when an SVC stream is added to ShowCase. Then
a small window appears that offers several SVC settings:

[svc] dependency_id max specifies the maximum
number of layers that should be decoded.

[svc] quality_id max specifies the maximum
'quality_id' value of layer which must be decoded. 

[svc] temporal_id max specifies the maximum
'temporal_id' value of layer which must be decoded.

Show base layers indicates whether base layers
should be decoded or not.

View them all allows you to display all layers at the
same time.
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The Preview Menu
The Preview menu offers several options for working with the size of the window which is
used for playback the video streams.

Preview in Original Size displays the source
video in its original size.

Preview in Half Size shows the source video in
half the original size.

Preview in Quarter Size displays the source video in a quarter of the original size.

When the Use Clock Synchronization option is disabled, the graph is played back non-
synchronously, i.e. the video streams are decoded as fast as possible. Please note that
you have to stop the decoding process before changing the option.

Please note that when you want to evaluate the decoder speed appro-
priately, you have to mute the audio first. Otherwise, the results are dis-
torted.

The Help Menu
Documentation... opens this manual as PDF file.

Info about... opens a window showing the cur-
rent version of MainConcept ShowCase and
some copyright information. Click OK to close it.
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The ShowCase Player Application Interface
In the following chapter we want to introduce the main window of the ShowCase player
software in more detail. The interface offers lots of useful controls and information for the
playback process.

On the left side of the interface, you see a display that shows the current timecode (TIME)
and frame rate (FPS). The last two digits in the timecode show the current frame number
during playback.

Next to the display, you seea slider and various buttons that perform the following func-
tions:

The slider allows you to scrub to the video. Using the arrow keys allows you to step back-
ward and forward framewise.

The Play button  starts the decoding of the stream. During playback it turns into a

Pause button , so that you can pause the decoding process any time, and resuming
it by clicking it again.

The Stop button  terminates the playback and finishes the graph.

When using the Loop Playback option , the video is played back over and over
again.

Click the Switch to Fullscreen Preview button  to enable fullscreen preview. To
return to the normal preview mode, simply press the Esc key on your keyboard.

The Mute Audio button  disables audio, so that only the video stream is played back.

Press this button  a second time to enable audio again. 
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In the current version of ShowCase, audio cannot be muted directly dur-
ing playback. You must first Stop the decoding process, then mute the
playback and Start it again. 

Depending on the currently used mode, the Select the network stream or playback file
button  enables you to specify a stream for playback that is received over a network
or to open a stream for file playback that is located on your system.

Attached to the main dialog, you have the preview window, where you watch the playback
of the video footage.
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The DirectShow Filters
To get an idea what happens inside the MainConcept ShowCase player application, we
want to give you a short introduction on the DirectShow filter, which is used for decoding
video and audio streams on your PC. In the software called GraphEdit - DirectShow
Graph Tool which is part of the DirectX SDK from Microsoft®, you can create graphs with
the filters installed and registered on your system. The following chapter provides a brief
overview of the DirectShow components.

What are DirectShow Filters?
As nucleus of DirectShow® there is a modular system of connectable components, the so
called Filters. These filters are arranged in a composition called a Filter Graph. The Filter
Graph Manager component monitors the connection of these filters and controls the data
flow stream. Applications that use the DirectShow architecture, control the activities of the
Filter Graph by communicating with the Filter Graph Manager. 

Most filters included in Microsoft® DirectShow® runtime reside in quartz.dll, while others
are standalone *.ax files. The DirectShow filters are *.dll files. Many of them are installed
to Windows\system directory and others are installed in the product's directory or in spe-
cific folders (e.g. some MainConcept filters are installed in the Program Files\Common
Files\MainConcept folder on the system drive).

Here are some useful information which might be important to know about filter data
streaming, connections and pins:

• Data streams in packets (called MediaSample) from Source to Renderer through 
Transform filters.

• The connection from one filter to another is realized with the help of a Pin. A pin is an 
object that belongs to the filter. It offers a connection to other filter pins. 

• The Input Pin receives the MediaSamples from an upstream filter, and the Output Pin 
sends the MediaSamples to a downstream filter.

• The Source filter has at least one output pin, the Renderer filter has at least one input 
pin, and the Transform filter has both input and output pins.
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DirectShow Filter Types
The DirectShow filters can be divided into the following three main classes: 

• Source Filter – provides the multimedia stream. It ranges from the File Source Filter
to the MPEG encoding device source or Network source. 

• Renderer Filter – finishes a graph. The most common Renderer filters are Video Ren-
derer and Audio Renderer, which play video and audio streams. A Renderer filter can
also be a File Dump or File Writer filter and a Network Render filter.

• Transform Filter – are the widest range of filters. All transformations on DirectShow®

streams are made in transform filters. This type of filter is divided into Transform and
TransInPlace filters. The TransInPlace filter differs from the Transform filter in mem-
ory allocation. It does not provide its own allocators, but uses ones from the upstream
or downstream filter. It sends the same MediaSample that it received from the
upstream to downstream filter and makes all data transformations in the MediaSam-
ple data buffer without changing its size.
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The DirectShow Filters’ Property Pages
All DirectShow filters included in MainConcept ShowCase have additional settings which
can be modified on the property pages if necessary. In the following, we want to describe
the option of the filters in more detail. The MainConcept ShowCase player includes an
H.264/AVC, SVC, MPEG-2, VC-1, DVCPRO HD, JPEG2000, Motion JPEG and MPEG-4
Part 2 Video Decoder as well as AAC and MPEG Audio Decoder. Moreover, the player
contains MPEG-2 Push and Pull Demultiplexer, MP4 Demuxer, MXF Demuxer and a net-
work stream receiver. The various options on the property pages enable you to optimize
the decoding of your streams. 

The Video Decoder Properties

The MainConcept H.264/AVC Decoder
The MainConcept H.264/AVC Video Decoder filter as standard version is a software-
only decoding solution for ISO/IEC 14496 part 10 AVC / ITU-T Recommendation H.264
video streams. The Decoder is implemented as a DirectShow® filter. The filter can pro-
cess AVC/H.264 video streams produced by the MainConcept MPEG Demultiplexer, MP4
Demuxer or any other compliant filter, such as Microsoft® MPEG-2 Demultiplexer. The fil-
ter can process Closed Captions (CC) and has a CC output pin. The CC data output is
executed in a way suitable for decoding by the software Line 21 decoder filter which
comes with DirectShow®. The Broadcast version of the decoder additionally supports
AVC-Intra Class 50 and Class 100.

The H.264/AVC Decoder offers two panes: About and Settings. We will describe the var-
ious settings in more details now. 

Hardware acceleration enables hardware accel-
eration via the DirectX Video Acceleration inter-
faces (if supported). It is available for both DXVA
1.0 and 2.0.

The Quality option specifies the types of frames
that the decoder will skip. In case of field pictures
the frame type is determined by the first coded
slice type of complimentary field pairs. Skip PB
decodes I frames only, skips P and B frames. The
frame type is determined by the type of first slice
of the first coded picture of a frame or complimen-
tary field pair. The parameter Skip B will decode I
and P frames only, skips B frames, even if they
are used for reference. When choosing Skip
none all frames are decoded without regard to

quality messages from a downstream filter. Obey quality messages responds to quality
messages from a downstream filter by skipping frames.
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The Error Concealment drop-down menu specifies how the decoder should handle
frames with mistakes or errors. Off means that all frames are decoded and shown. When
choosing Don't show frames with errors, the decoder does not display frames, in which
mistakes or errors are detected.

The Deblocking drop-down menu controls in-loop filter operation. It offers three options.
Standard respects the stream settings. The Only reference option runs the in-loop filter
for reference pictures only. Disabling the option with Off skips the in-loop filter for all pic-
tures. The latter may produce artifacts in some cases.

The Chroma Upsample option can improve the visual quality of the decoded video
(chrominance component). On enables the option and Off disables it again.

The Deinterlacing option specifies the deinterlacing mode which should be used. Auto
enables an automatic deinterlacing if the picture type is field or MBAFF. If Weave is
selected the decoder will not deinterlace and it will output interleaved fields. The option
Vertical filter deinterlace selects the vertical deinterlace function. Field interpolation
will do deinterlace by interpolation. VMR Deinterlacing will put the correct interlacing
flags on output samples and let VMR (Video Mixing Renderer) decide on deinterlacing.

The Double Rate option enables (On) and disables (Off) the generation of one progres-
sive frame from every field.

The Fields Reordering option changes the order of fields by changing the specific media
sample flags. Off disables the feature. When using the Invert flags option the fields are
reordered by inverting the specific media sample flags. Invert fields reorders the fields by
exchanging the fields in a picture.

Condition of Fields Reordering specifies the condition when fields must be reordered.
Always enables permanent reordering. Top field is first is specified if the TopFirst flag is
TRUE. Bottom field is first is set if TopFirst flag is FALSE.

SMP offers various Hyper-Threading options if they are available. Auto checks for multi-
threading and using "by picture" mode it is available. The option By pictures offers par-
allel decoding by pictures. By slices allows parallel decoding by slices. Finally, the option
Off allows serial decoding.

Number of threads specifies the number of threads that should be used for decoding.

Synchronization specifies the PTS (Presentation Time Stamp) usage for calculating the
output time. PTS transfers the incoming PTS from input bit stream to output frames. PTS
(reference only) allows to transfer PTS only for reference frames, interpolate PTS for
non-reference frames based on frame rate. Direct timestamps uses direct timestamps
for calculating the output time. Finally, the option Off interpolates all output PTS based on
frame count and frame rate.
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Rate interpretation specifies the way of interpretation of the frame rate value. In accor-
dance with the standard this value should correspond to the field rate. The available
options are Field rate, Frame rate and Fixed rate.

Fixed frame rate specifies the value of frame rate. 

Enabling (On) the OSD (On-Screen Display) option shows some decoding/stream statis-
tics (picture type, frame-rate etc.). It is only available in software mode (i.e. it is not avail-
able for DXVA). It can be disabled by setting it to Off.

Format type sets video format structure for the output Media Type. It offers the following
options: Only VIDEOINFO connections are allowed. Only VIDEOINFO2 connections are
allowed. The option Both means that VIDEOINFO and VIDEOINFO2 connections are
allowed.

Low Latency allows you to enable and disables the minimal output delay.

Stream Order enables/disables the output of frames in stream order.

The MainConcept SVC Decoder
The MainConcept SVC Video Decoder filter is a software-only decoding solution for
ISO/IEC 14496 part 10 AVC / ITU-T Recommendation H.264 and SVC video streams.
The Decoder is implemented as a DirectShow® filter. The filter can process SVC (Scal-
able Vide Coding) Baseline/Main Profile as well as AVC/H.264 video streams.

The SVC Decoder offers two panes: About and Settings. It offers the same settings as
the H.264/AVC Decoder from the previous chapter, but additionally offers some specific
SVC options. We will describe the various settings in more details now. 

Hardware acceleration enables hardware accel-
eration via the DirectX Video Acceleration inter-
faces (if available).

The Quality option specifies the types of frames
that the decoder will skip. In case of field pictures
the frame type is determined by the first coded
slice type of complimentary field pairs. Skip PB
decodes I frames only, skips P and B frames. The
frame type is determined by the type of first slice
of the first coded picture of a frame or complimen-
tary field pair. The parameter Skip B will decode I
and P frames only, skips B frames, even if they
are used for reference. When choosing Skip
none all frames are decoded without regard to
quality messages from a downstream filter. Obey
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quality messages responds to quality messages from a downstream filter by skipping
frames.

The Error Concealment drop-down menu specifies how the decoder should handle
frames with mistakes or errors. Off means that all frames are decoded and shown. When
choosing Don't show frames with errors, the decoder does not display frames, in which
mistakes or errors are detected.

The Deblocking drop-down menu controls in-loop filter operation. It offers three options.
Standard respects the stream settings. The Only reference option runs the in-loop filter
for reference pictures only. Disabling the option with Off skips the in-loop filter for all pic-
tures. The latter may produce artifacts in some cases.

The Chroma Upsample option can improve the visual quality of the decoded video
(chrominance component). On enables the option and Off disables it again.

The Deinterlacing option specifies the deinterlacing mode which should be used. Auto
enables an automatic deinterlacing if the picture type is field or MBAFF. If Weave is
selected the decoder will not deinterlace and it will output interleaved fields. The option
Vertical filter deinterlace selects the vertical deinterlace function. Field interpolation
will do deinterlace by interpolation. VMR Deinterlacing will put the correct interlacing
flags on output samples and let VMR (Video Mixing Renderer) decide on deinterlacing.

The Double Rate option enables (On) and disables (Off) the generation of one progres-
sive frame from every field.

The Fields Reordering option changes the order of fields by changing the specific media
sample flags. Off disables the feature. When using the Invert flags option the fields are
reordered by inverting the specific media sample flags. Invert fields reorders the fields by
exchanging the fields in a picture.

Condition of Fields Reordering specifies the condition when fields must be reordered.
Always enables permanent reordering. Top field is first is specified if the TopFirst flag is
TRUE. Bottom field is first is set if TopFirst flag is FALSE.

SMP offers various Hyper-Threading options if they are available. Auto checks for multi-
threading and using "by picture" mode it is available. The option By pictures offers par-
allel decoding by pictures. By slices allows parallel decoding by slices. Finally, the option
Off allows serial decoding.

Number of threads specifies the number of threads that should be used for decoding.

Synchronization specifies the PTS (Presentation Time Stamp) usage for calculating the
output time. PTS transfers the incoming PTS from input bit stream to output frames. PTS
(reference only) allows to transfer PTS only for reference frames, interpolate PTS for
non-reference frames based on frame rate. Direct timestamps uses direct timestamps
for calculating the output time. Finally, the option Off interpolates all output PTS based on
frame count and frame rate.
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Rate interpretation specifies the way of interpretation of the frame rate value. In accor-
dance with the standard this value should correspond to the field rate. The available
options are Field rate, Frame rate and Fixed rate.

Fixed frame rate specifies the value of frame rate. 

Enabling (On) the OSD (On-Screen Display) option shows some decoding/stream statis-
tics (picture type, frame-rate etc.). It is only available in software mode (i.e. it is not avail-
able for DXVA). It can be disabled by setting it to Off.

Format type sets video format structure for the output Media Type. It offers the following
options: Only VIDEOINFO connections are allowed. Only VIDEOINFO2 connections are
allowed. The option Both means that VIDEOINFO and VIDEOINFO2 connections are
allowed.

Low Latency allows you to enable and disables the minimal output delay.

Stream Order enables/disables the output of frames in stream order.

[svc] dependency_id max specifies the maximum number of layers that should be
decoded.

[svc] quality_id max specifies the maximum 'quality_id' value of layer which must be
decoded. 

[svc] temporal_id max specifies the maximum 'temporal_id' value of layer which must
be decoded.

[svc] Show base layer indicates whether base layers should be decoded or not.
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The MainConcept MPEG-2 Video Decoder
The MainConcept MPEG-1/2 Video Decoder filter is a software-only decoding solution
for MPEG-2 video (ISO/IEC 13818-2) and MPEG-1 video (ISO/IEC 11172-2) streams.
The Decoder is implemented as a DirectShow® filter. The filter can process MPEG video
streams produced by the MainConcept MPEG2 Demultiplexer filter or by any other com-
pliant filter, such as Microsoft® MPEG-2 Splitter, MPEG-2 Demultiplexer or MPEG-1
Stream Splitter. DirectShow® filters provide additional stream handling, such as reading
from a file or network source and rendering it to a window or DirectDraw® surface. The fil-
ter can process Closed Captions (CC) and has a CC output pin. The CC data output is
executed in a way suitable for decoding by the software Line 21 decoder filter which
comes with DirectShow®. 

The MPEG-2 Video Decoder offers two panes: About and Settings. We will describe the
various settings in more details now. 

Quality sets the decoding quality of the stream.
The option offers four settings: Decode I frames
only decodes I frames only, but skips P and B
frames. For field pictures, decodes second field
of I frame, which comes as a P picture. Decode
I, P frames only decodes I and P frames only,
but skips B frames. Decode all frames (I, P, B)
decodes all frames without regard to quality
messages from the upstream filter. Obey quality
messages responds to quality messages from
the downstream filter by skipping frames.

Brightness sets the brightness level.

Hardware acceleration enables hardware
acceleration via the DirectX Video Acceleration
interfaces (if available).

The Hardware acceleration feature is enabled by default. If you
encounter some picture errors during playback, we recommend to dis-
able the hardware acceleration and try again if the problems disappear.
Some graphics cards cause problems with hardware acceleration
turned on.

Resolution specifies the output resolution mode. The option offers four parameters Full,
Half horizontal (output video becomes ½ of original frame width), Half vertical (output
video becomes ½ of original frame height), and Quarter (output video becomes ½ of orig-
inal frame width and height).
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IDCT precision specifies the precision of IDCT procedure. The option offers two settings
Integer (IEEE-1180 integer precision IDCT), and Float (IEEE-1180 reference double pre-
cision floating point IDCT).

Post process removes the MPEG compression artifacts using deblocking and deringing
filters.

Deinterlace sets the deinterlacing mode. There are four modes available: Weave does
not deinterlace, but output interleaved fields. Vertical filter deinterlace selects vertical
deinterlace function). Field interpolation does deinterlacing by interpolation. VMR Dein-
terlacing puts correct interlacing flags on output samples and lets VMR (Video Mixing
Renderer) decide on deinterlacing.

Condition of deinterlace specifies the condition when the decoder must deinterlace out-
put frames. Here you find the following options: Always, Interlaced frames, and Pro-
gressive frames.

Upsample improves visual quality of decoded video (chrominance component).

Double rate generates one progressive frame from every field.

Fields reordering changes the order of fields by changing the specific media sample
flags.

Condition of fields reordering specifies the condition when fields must be reordered:
Always, If TopFirst flag is true, or If TopFirst flag is false.

Format type sets video format structure for the output Media Type. The option offers
three parameters: only VIDEOINFO connections are allowed, only VIDEOINFO2 connec-
tions are allowed, and Both VIDEOINFO and VIDEOINFO2 connections are allowed.

OSD enables the ‘On screen display’ feature (displaying of the decoding statistical infor-
mation).

CC CCube decode order parses several different Closed Caption formats.

Error concealment sets the error concealment mode. When set to Off, the error conceal-
ment is disabled. Not show frames with errors enables error concealment is enabled
(frames with errors are not shown).

SMP enables Hyper-Threading if it is available.

Media Time Source displays the source (input/GOP time code) of media times.

Enable VMR maintain aspect ratio to preserve the aspect ratio of the source video when
the output video pin is connected to the VMR.

Aspect Ratio forces the picture aspect ratio. Available options are Default, 1x1, 4x3 and
16x9.

Set media time allows you to set media times on output media samples, which are deliv-
ered from the «VideoOut» pin.
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Synchronization specifies the PTS (Presentation Time Stamp) usage for calculating the
output time. PTS transfers the incoming PTS from input bit stream to output frames. PTS
(reference only) allows to transfer PTS only for reference frames, interpolate PTS for
non-reference frames based on frame rate. Direct timestamps uses direct timestamps
for calculating the output time. Finally, the option Off interpolates all output PTS based on
frame count and frame rate.

The option Condition of CC byte pairs processing sets the condition of CC byte pairs
processing.

Stream order specifies whether the decoder should display the output frames in stream
order or not.

The MainConcept MPEG-4 Part 2 Video Decoder
The MainConcept MPEG-4 Video Decoder filter is a software-only decoding solution for
MPEG-4 (ISO/IEC 14496-2) streams. The decoder is implemented as a DirectShow® fil-
ter. The filter can process ISO/IEC 14496-2 video streams produced by the MainConcept
MPEG Demultiplexer filter, MainConcept MP4 Demultiplexer filter or by any other compli-
ant filter, such as DivX, Xvid Video Encoders etc.

The MPEG-4 Part 2 Video Decoder offers two panes: About and Settings. We will
describe the various settings in more details now. 

Skip mode sets the decoding quality of the
stream. The option offers four settings: Decode I
frames only decodes I frames only, but skips P
and B frames. For field pictures, decodes second
field of I frame, which comes as a P picture.
Decode I, P frames only decodes I and P
frames only, but skips B frames. Decode all
frames (I, P, B) decodes all frames without
regard to quality messages from the upstream fil-
ter. Obey quality messages responds to quality
messages from the downstream filter by skipping
frames.

The Error Resilience mode drop-down menu
specifies the way the H.264/AVC decoder recovers from bit stream errors. The option
Skip till Intra is useful in case of bit stream errors. Then all slices until the next intra slice
are skipped. It may produce artifacts if pictures before an intra slice are used as a refer-
ence for pictures after an intra slice. Decode anyway ignores bit stream errors.

Post processing allows performing a computationally intensive post process procedure
that causes smoothing edges of highly quantized blocks.
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Deblock strength (%) specifies the percentage rate of the deblocking filter's usage.

Brightness sets the brightness level.

Contrast sets the contrast level.

The Display OSD option enables/disables ‘On screen display’ feature (displaying of the
decoding statistical information such as current frame type, number of decoded frames,
number of skipped frames).

Deinterlace sets the deinterlacing mode. There are four modes available: Weave does
not deinterlace, but output interleaved fields. Vertical filter deinterlace selects vertical
deinterlace function). Field interpolation deinterlaces by interpolation. VMR Deinterlac-
ing puts correct interlacing flags on output samples and lets VMR (Video Mixing Ren-
derer) decide on deinterlacing.

IDCT precision forces the decoder to use the double precision reference IDCT algorithm.
By default, the decoder uses the optimized CPU-specific IEEE-1180 compliant Integer
IDCT. As a reference, the double precision IDCT algorithm from the IEEE 1180-test was
used (Float). This algorithm is useful for editing applications due to the high precision,
though it is quite slow regarding the order of magnitude.

Stream order specifies whether the decoder should display the output frames in stream
order or not.

Whole frame per sample forces decoder to assume that every sample buffer contains
complete frame  to process it and send ready frames to renderer immediately.
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The MainConcept VC-1 Video Decoder
The MainConcept VC-1 Decoder filter is a software-only decoding solution for SMPTE
421M-2006 (VC-1) video streams. The Decoder is implemented as a DirectShow® filter
and can be used by any DirectShow® application (e.g. Windows® Media Player). The
filter can process VC-1 video streams produced by the MainConcept MPEG
Demultiplexer or any other compliant filter, such as Microsoft® ASF Reader.

Skip Mode specifies types of frames that
decoder will skip. In case of field pictures frame
type is determined by the type of first coded slice
of complimentary field pair. None decodes all
frames without regard to quality messages from
a downstream filter. Decode reference only
decodes all reference frames, skips non-refer-
ence frames. Decode intra only decodes I
frames only, skips P and B frames. In case of
field coding, frame type is determined by the type
of first coded picture of a complimentary field
pair. Auto responds to quality messages from a
downstream filter by skipping frames.

Error Resilience Mode specifies the way decoder recovers from bit stream errors. Skip
till Intra skips all slices till next intra slice in case of bit stream errors. Decode anyway
ignores bit stream errors.

SMP mode offers various Hyper-Threading options if they are available. Auto checks for
multi-threading and using "by picture" mode it is available. The option By pictures offers
parallel decoding by pictures. By slices allows parallel decoding by slices. Finally, the
option Off allows serial decoding.

Number of threads specifies the number of threads that should be used for decoding.

Use hardware acceleration enables hardware acceleration via the DirectX Video Accel-
eration interfaces (if available).

VideoInfo enables or disables the usage of the VIDEOINFOHEADER format structure
along with VIDEOINFOHEADER2.

Stream order specifies whether the decoder should display the output frames in stream
order or not.

HQ Chroma Upsample improves the visual quality of decoded video (chrominance com-
ponent).

Deinterlace sets the deinterlacing mode. When choosing Weave no deinterlace is done
and the decoder outputs interleaved fields. Vertical filter deinterlace applies a vertical
deinterlace function. Field interpolation enables deinterlace by interpolation. VMR Dein-
terlacing puts correct interlacing flags on the output samples and let the VMR (Video Mix-
ing Renderer) decide on deinterlacing.
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Double rate generates one progressive frame from every field.

Fields reordering changes the order of fields by changing the specific media sample
flags.

Condition of fields reordering specifies the condition when fields must be reordered.
There are three options: Always, Top field is first and Bottom field is first.

OSD enables or disables the displaying of frame statistical information on output images.
Useful for debugging.

Synchronizing sets the synchronization mode used by decoder. Use PTS transfers the
incoming PTS from the input bit stream to the output frames. Ignore PTS on non-refer-
ence frames transfers the PTS only for reference frames, interpolates the PTS for non-
reference frames based on the frame rate. Ignore all PTS interpolates all output PTS
based on frame count and frame rate.

Output YV12 enables or disables YV12 color space (native VC-1 format) output.

Output YUY2 enables or disables YUY2 color space output.

Output UYVY enables or disables UYVY color space output.

Output RGB32 enables or disables RGB32 color space output.

Output RGB24 enables or disables RGB24 color space output.

Output RGB565 enables or disables RGB565 color space output.

Output RGB555 enables or disables RGB555 color space output.
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The MainConcept DV/DVCPRO 25/50/HD Video Decoder
The MainConcept DVCPRO HD video decoder DirectShow filter allows decoding of
consumer DV 25 MBit (IEC-61834), DVCPRO 25/50 Mbit (SMPTE 314M), and DVCPRO
HD in 720 50/60p and 1080 50/60i (SMPTE 370M).

The Fast decoding checkbox enables the
usage of fast decoding method. This will result in
slightly lower quality.

Change field order allows you to invert the
upper and lower field.

Decode to CIF size play back the video streams
in CIF format.

RGB 16..235 specifies the usage of the RGB for-
mat as clamped format: (16,16,16) is black,
(235,235,235) is white.

Clamp YUV to ITU-610r allows clamping YUV values to ITU601R legal values.

Disable 16x9 ignores the 16x9 flag in DV (CIF only).

The MainConcept JPEG2000 Video Decoder
The MainConcept JPEG2000 (also known as J2k) Video Decoder filter allows software-
only decoding of JPEG2000 video (ISO/IEC 15444-1) streams. It is fully DCI compliant.

The Decoder Properties tab offers the following
options under quality settings:

Select layers for decoding allows you to specify
the max. number of layers for decoding. 0
decodes all layers, 1 decodes layer 1 only, 2
decodes layer 1 through 2 only, 3 decodes layer 1
through 3 only, etc.

Downsample factor defines the downsampling
factor exponent.

Acceleration mode sets the appropriate accel-
eration mode.

When Obey quality messages is selected, the
filter handles the quality messages generated
with the video renderer.
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Number of codepasses to skip adjusts the level of quality degradation in favor of faster
playback. The parameter sets the number of codepasses to skip at bit level decoding of
the bitstream. Accepted values are from 0 to 31. But, if the value will be more than 23, the
user will not be able to see the image. Therefore, the real maximal value is limited to 23.

Under colour settings you find the following options:

Disable RGB3 disables the RGB3 output.

Disable RGB4 disables the RGB4 output.

Disable RGBA disables the RGBA output.

Disable UYVY disables the UYVY output.

Convert DCI XYZ to rgb/yuv enables transform from DCI's xyz format.

Under general settings you find the following options:

Number of threads specifies the number of threads that should be used for decoding.

Low-delay mode enables inter (No) or intra (Yes) frame multithreading.

Flip the image turns the picture upside down.

Deinterlace sets the deinterlace mode. None disables the option, so decoder uses inter-
lace. If you select Weave no deinterlace is done, i.e. the decoder outputs interleaved
fields. VMR puts correct interlacing flags on output samples and lets VMR (Video Mixing
Renderer) decide on deinterlacing.

Default settings restores the J2k decoder to its default settings.
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The Decoder Advanced Properties tab pro-
vides information about the following parame-
ters:

Average frame rate, fps indicates the average
frame rate (read-only).

Average bit rate, kbps displays the average
bitrate (read-only).

Skipped frames indicates the number of
skipped frames during decoding (read-only).

Skipped passes indicates the number of code-
passes to skip at bit level decoding of the bit-
stream (read-only).

The MainConcept Motion JPEG Video Decoder
The MainConcept MJPEG allows you to read analog video footage on your computer. It
is optimized for MMX technology. The filter should be able to decode PAL/NTSC coded
AVIs in near realtime. It can decode Motion-JPEG (Movie-JPEG, MJPEG, MJPG) AVIs,
created with Miro (DC10, DC20 and DC30), FAST, Matrox and similar cards.

The decoder currently supports RGB16, RGB24,
YUY2 and UYVY color spaces as input formats. It
is possible to disable the YUY2 and UYUY color
spaces by activating the Disable YUV checkbox.

One Field Only decodes only one field of inter-
laced MJPEG AVIs, which is much faster than
encoding both fields.

Use Full Range Color specifies whether the
ITU601 recommendations should be ignored or
not.

Inverted Field Order simply reverses the field
order.
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The MainConcept VC-3 Video Decoder
The MainConcept VC-3 Decoder filter is a software-only decoding solution for SMPTE
2019-2006 (VC-3) video streams. It allows the decoding of DNxHD compliant streams.

Quality specifies the decoding quality. Decode
all frames allows you decoding all frames with-
out regard to quality messages from the down-
stream filter. Obey quality messages responds
to quality messages from the downstream filter
by skipping frames.

Decoded frames displays the number of
decoded frames.

Decoded bytes displays the number of decoded
bytes.

Time of the last frame dislpays the time of the
last decoded frame.
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The Audio Decoder Properties

The MainConcept AAC Decoder
The MainConcept AAC Decoder filter enables the software-only decoding of MPEG-2
(ISO/IEC 13818-7) and MPEG-4 (ISO/IEC 14496-3) AAC audio streams.

The demo version of the AAC Decoder DirectShow filter has an decod-
ing limitation of 30 seconds for files which include AAC audio, i.e. after
this period of time audio is muted and only video is played back cor-
rectly.

The AAC Decoder offers two panes: About and Settings. It only has two settings right
now. 

Deliver channels specifies the output channels
configuration: Both, First and Second.

Bit depth specifies the output bit depth.

Insert silence on bitstream errors specifies
whether silence should be added on bitstream
errors or not.

The Mute option allows you to mute the audio
during playback.
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The MainConcept MPEG Audio Layer 1&2 Decoder
The MainConcept MPEG Audio Decoder filter enables the software-only decoding of
MPEG-1, MPEG-2, MPEG-2.5, LPCM audio streams.

Here are the MPEG Layer II Audio Decoder filter’s Input Stream Info options. They are
all read-only items: 

Input stream type indicates type of the input
audio. The possible values are: MPEG-1, MPEG-
2, MPEG-2.5, and LPCM.

Mode shows the MPEG audio layer of the stream
according to ISO/IEC 11172-3 and 13818-3.

Channels config shows the channel configura-
tion for MPEG and AC-3 streams.

Bit stream ID indicates the bit stream ID.

Quantisation shows the quantization value for LPCM streams.

Number of channels displays the number of channels in LPCM streams.

Sample rate (Hz) shows the sample rate value.

Bit rate (kbps) displays the bitrate value.

Here are the MPEG Layer II Audio Decoder filter’s General settings. It includes some
general settings for all decoders: MPEG, AC-3, AAC, LPCM, ProLogic II.

Bit per sample specifies output sample quantiza-
tion. The available parameters are 16 and 32.

The Mute option mutes (On) the output.

When enabling MPEG, LPCM, AES3 you find two more options among the MPEG Layer
II Audio Decoder filter settings. It includes some general settings for MPEG, AES3 and
LPCM decoders.
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Output channels config specifies the configura-
tion of output channels. Available values are:
Auto, Stereo and Mono.

MPEG channel configures the MPEG channels
for reproduction. Available values are: Both, First
and Second.

The Demultiplexer Properties

The MainConcept MPEG Pull Demultiplexer
The MainConcept MPEG Pull Demultiplexer filter is a DirectShow® filter designed for
the software-only splitting of MPEG-1 System Streams, MPEG-2 Program Streams and
MPEG-2 Transport Streams into video and audio streams. The Pull Demultiplexer oper-
ates with subpicture streams and allows for the parsing of MPEG-1 and MPEG-2 video-
only streams and H.264 video streams. The MainConcept MPEG Pull Demultiplexer filter
performs seek operations in a media file by using Presentation Time Stamps (PTS),
bitrate or MainConcept indexing technology. It is fully compatible with the MainConcept
MPEG-2 Video Decoder and the MainConcept MPEG Audio Decoder.

The MPEG Pull Demultiplexer offers two panes: About and Settings. We will describe
the various settings in more details now.

The Stream Type parameter shows the type of
the detected stream after connecting to the
source.

The Init Mode option specifies an algorithm of
the initial stream duration calculation. Normal ini-
tialization mode, scans the stream and checks
the monotony of the PTS (Presentation Time
Stamp) increment. If PTS is incremented mono-
tonically, the duration is calculated by PTS. If
there is a gap or reset of PTS, the duration is cal-
culated by bitrate. The Simple initialization mode,
does not perform the stream scanning to check
monotony of the PTS increment. The duration is
always calculated by PTS. 

Subpicture Support enables (On) and disables (Off) the subpicture streams support.

Support TS without PSI /*limited/ specifies whether the first video PID belongs to the
first audio PID or not (if there is no PAT/PMT present).
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The MainConcept MP4 Demuxer
MainConcept MP4 Demuxer is a DirectShow® filter that provides demultiplexing of
MPEG-4 (Intermedia Format (MP4)), 3GPP System streams into a MPEG-4, H.263, AVC/
H.264 video streams and AAC, MPEG-1/2 Audio Layer 3 audio streams. MainConcept
MP4 Demultiplexer is fully compatible with MainConcept MPEG-4 Video Decoder, Main-
Concept AVC/H.264 Video Decoder, ffdshow MPEG-4 Video Decoder, 3ivx D4 Video
Decoder, MainConcept Audio Decoder, ffdshow Audio Decoder and 3ivx D4 Audio
Decoder.

The MP4 Demuxer offers two panes: About and Settings. We will describe the few set-
tings in more details now.

Ticking the checkbox Use field rate for H.264/
AVC activates the correct time stamps calculation
for H.264/AVC, when the field rate is used in the
sequence header instead of the frame rate.

Ticking the checkbox Annex B output for H.264/
AVC produces H.264/AVC output in conformity
with ISO/IEC 14496-10 Annex B.

Ticking the checkbox ADTS headers for AAC
adds an ADTS header to each AAC sample.
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The MainConcept DV Splitter
The MainConcept DV Splitter filter splits an interleaved digital video (DV) stream into its
component video and audio streams.

Do dynamic format change enables and dis-
ables the dynamic format change during stream-
ing. 

The Audio channels checkboxes specify the fit
channels. Channels that are lacking an input
stream are grayed. The marked ones will be
included in the output audio stream.

The MainConcept MXF Demuxer
The MainConcept MXF Demuxer filter provides demultiplexing of MXF (Material
eXchange Format) streams, such as XDCAM HD, XDCAM IMX, P2 DVCPRO HD, P2
AVC-Intra, JPEG2000, etc.

Separate audio channels allows that the
demuxer creates one output pin for each audio
channel.

Parse external streams allows to parse external
streams (for Panasonic P2, Ikegami).
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The Network Source Properties

The MainConcept Network Source
The DirectShow filter Network Source supports two protocols: RTP (connecting to
broadcast servers) and RTSP (video on demand). The filter can receive media streams
from the network: AVC/H.264 Video, MPEG-4 Video, AAC Audio, MPEG-1 System
Stream, MPEG-2 Transport Stream, MPEG-2 Program Stream, Audio, MPEG-1 Video,
MPEG-1 Audio (including MPA-Robust for MPEG-1 Layer-3 Audio according to RFC-
3119), MPEG-2 Video, MPEG-2 Audio, and AC-3 Audio.  

The Network Source Settings pane

The Settings pane offers various general options
for the filter:

Local Network interface address defines the
interface address of the local network. 

URl for the stream specifies the URI path for the
stream.

Transport Type specifies the transport type of
received data. The available options are Unicast
RtpAvpUdpMode, InterleavingMode, Multicast

RtpAvpMod,  UnicastRawUdpMode, MulticastRawMode, UnicastRawTcpMode. 

Enable RTCP mode enables (Yes) or disables (No) the RTCP mode.

Enable buffering allows you enable (Yes) and disable (No) the stream buffer.

Source port displays the source port from which the data is received

Server connection port specifies the connection server port.

SAP Multicast Port declares the multicast group for the announces (from which address
SDP should be received, i.e. RFC2974 or any user defined address).

Destination Address specifies the main connection address (multicast group under
RTSP, and indicates media data supplier address under RTP mode).

RTSP Server Address specifies the RTSP server address.

Timeout (sec.) specifies the time out value in seconds.

Playback Speed it is a scale value, which is actual only for RTSP mode to change the
playback rate.

Stream duration (sec.) retrieves the duration stream from SDP in seconds.

Server URI retrieves the server URI from SDP.

Session name retrieves the session name from SDP.
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Server e-mail retrieves the server e-mail from SDP.

Server phone retrieves the server phone from SDP.

Session Info is a description field that displays values from SDP (RFC2327). 

The Network Source Announcements pane

The Announcements pane displays some infor-
mation on the current session, such as Server
name, Server address and Network interface
address. 

The Network Source SDP/URL pane

In the field in the middle of the SDP/URL pane
you see the Path information of the streams you
find under the corresponding network address.

The four buttons below perform these functions:

Add SDP file allows you to load the necessary
SDP file (Session Description Protocol), in which
all necessary settings for RTP streaming (simple
broadcasting) are present. The client will auto-
matically make a connection.

Add URL can be used for playlist generating. The protocol will be automatically detected,
Here are some examples:

rtp://234.5.6.7:1234 - will automatically make a connection on 234.5.6.7 multicast group
on port = 1234, via RTP (UDP will be used as lower transport);

udp://234.5.6.7:1234 - will automatically make a connection on 234.5.6.7 multicast group
on port = 1234, for simple UDP broadcasting;

tcp://192.157.4.3:1234 - will automatically make a connection on 192.157.4.3 unicast
address on port = 1234, for simple TCP streaming;
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rtsp://192.156.5.6:554/stream1.mp4 - will automatically make a connection on
192.156.5.6 unicast address (RTSP server address) on port = 554, for RTSP session.
Protocol and other settings are adjusted via "Settings" tab, before URL will be applied.

Delete removes the selected connection from the list.

Clear resets the current Path display list.

The MainConcept MPEG Push Demultiplexer
The MainConcept MPEG Push Demultiplexer filter is a software-only MPEG splitter
implemented as a Microsoft® DirectShow® transform filter. The MainConcept MPEG
Push Demultiplexer is designed to split MPEG-2 (ISO/IEC 13818-2) and MPEG-1 (ISO/
IEC 11172-2) streams provided by source or transform filters in Push (Sync) mode into
video and audio streams. It is fully compatible with the MainConcept MPEG-2 Video
Decoder and the MainConcept Audio Decoder. 

The MPEG Push Demultiplexer offers two panes: About and Settings. We will describe
the various settings in more details now.

Stream detection completed is a read-only
option. It indicates the status of the stream
detecting process.

Stream type shows the recognized stream type.

Playback speed adjustment enables (On) and
disables (Off) the reference clock generation
and adjustment of the playback rate.

The drop-down menu Adjustment method of
playback speed offers two options: When you
select Adjust generated clock, the demulti-
plexer provides the reference clock with the time
which is adjusted in accordance with the input
data rate. Adjust time stamps sets the demulti-

plexer's time stamps on output samples that depend on the input data rate.

Latency value for time adjustment indicates the value that is used for the playback rate
adjustment. This parameter specifies the latency between the data reception and play-
back, that may be needed to avoid the playback jerking.

Stream time delta indicates the maximum time delta inside the stream (read-only).

Clock time delta displays the current difference between the time reported by the refer-
ence clock and the outgoing time stamps. It is a read-only parameter as well.

The drop-down menu Generation of PSI output turns On the demultiplexer to work with
manually created output pins. It can be disabled with Off.
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The MeritMe! Tool
Using the MeritMe! Tool

The MeritMe! tool enables you to change the merit of all installed MainConcept Video and
Audio Decoder as well as Demultiplexer DirectShow filters. The aim of it is to increase the
priorities of the filters that should be used to play back a file in the Media Player.

The MeritMe! tool does not only display the DirectShow filters that come
with a MainConcept Decoder Pack or ShowCase. It shows all MainCon-
cept audio/video decoders and demultiplexers that are currently regis-
tered on your system. It also informs you whether these filters are
installed as demo or as full versions.

Every filter is installed with a specific merit on a system. As already mentioned in the pre-
vious chapter, when playing back a clip in the Media Player, you cannot be sure that the
MainConcept filters are used. This might cause problems when DirectShow filters from
different companies are mixed, in order to decode a stream. Using the MeritMe! tool, you
can define a specific priority for the installed MainConcept DirectShow filters, so you can
increase and decrease the usage of a decoder or demuxer.

When you start MeritMe! from the Windows Start menu, the following dialog appears:

Under Filter Name you find the list of registered MainConcept DirectShow audio and
video decoder as well as demuxer filters. The list contains demo as well as full versions.

Current Merit displays the current merit of a DirectShow filter.

Filter Location shows the path where the filter is registered on your system. You can
select the link and copy it to the Explorer by using Ctrl+C.
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DirectShow filters that have been registered, but are not in their actual
location anymore, are marked with an <Invalid Path> extension before
the entry.

The New Merit drop-down menu enables you to specify the new merit for a filter. It offers
the following parameters:

• Default: Sets the filter back to its original values when it was registered the first
time.

• Disable: Disables the DirectShow filter, so that it is not used anymore
(MERIT_DO_NOT_USE =  0x00200000).

• High: Sets the filter’s merit to the maximum (0xFFFFFFFF), so that it should
definitely be used when decoding a specific format.

• Custom: When choosing this option, and input prompt will be enabled, where
you can enter the new merit as a hexadecimal value.

Under Custom Merit the value is displayed that you have entered manually.

The Unregister button in the last column enables you to unregister the selected filter. The
filter entry is then removed from the list completely.

At the bottom of the MeritMe! tool are three buttons that perform the following functions:

• Register new filters: This option opens a new window that enables you to look
for DirectShow filters (*.ax) on your system. Select the desired filters you want to
register and confirm with OK. Now they can also edited in MeritMe for future
use! 

• Refresh: Clicking the button refreshes the current status and view of the Direct-
Show filters in the MeritMe! tool.

• Reset: Press the button, in order to set all filters back to their original setting, i.e.
to the state when they have been registered the first time on your system.

• Close: Click this button to leave the MeritMe! tool.
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IMPORTANT NOTE:

Under Microsoft Windows Vista, you need to run MeritMe! as “Run as administra-
tor...”, otherwise you will get an Access Denied system error message when registering
or unregistering new DirectShow filters. When registering a new filter the following error
message might appear:

If this is the case, please start MeritMe! as administrator and repeat the task. The same is
valid when you receive the following message. 

However, this message box is displayed by the MeritMe! tool, and not by your operating
system.
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Technical Support
MainConcept Support

If you want more information about MainConcept ShowCase, visit our website at
www.mainconcept.com. Visit the Support section for a variety of resources.

If you need additional assistance, the MainConcept Technical Support team is standing
by to help. Send an e-mail to support@mainconcept.com, and we will assist you as
quickly as possible.

Additional Information
Be sure to check the MainConcept website frequently for updated tips, tricks, tutorials and
other information on software decoding.

Thank you for choosing MainConcept ShowCase!
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